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FOXIT CORPORATION LICENSE
AGREEMENT FOR FOXIT PDF
IFILTER SERVER

IMPORTANT-READ CAREFULLY: This Foxit Corporation (“Foxit”) License
Agreement ("License" or “Agreement”) is a legal agreement between You (either an
individual or an entity, who will be referred to in this License as "You" or “Your”) and
Foxit for the use of Foxit PDF IFilter, and which may include associated media, printed
materials, and other components and software modules including but not limited to
drivers ("Product"). The Product also includes any software updates and upgrades
that Foxit may provide to You or make available to You, or that You obtain after the
date You obtain Your initial copy of the Product, to the extent that such items are not
accompanied by a separate license agreement or terms of use. BY INSTALLING,
COPYING, DOWNLOADING, ACCESSING OR OTHERWISE USING THE
PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS OF THIS FOXIT
LICENSE AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT YOU HAVE NO RIGHTS TO THE PRODUCT AND SHOULD NOT
INSTALL, COPY, DOWNLOAD, ACCESS OR USE THE PRODUCT.

The Product is protected by copyright laws as well as other intellectual property laws.
The Product is licensed and not sold.

1. GRANT OF LICENSE. Foxit grants You a non-exclusive, nontransferable license to
install and use the Product subject to all the terms and conditions set forth here within.

1.1. Single-Use Perpetual License. You may permit a single authorized end
user to install the Product on a single computer for use by that end user only.
Remote access is not permitted without the express written consent of Foxit.

1.2. Single-Use Term License. Same usage terms as the Single-Use
Perpetual License. The period of use is limited to a fixed duration at which the
time the Product must be deinstalled from the computer unless the license is
renewed for an additional period of time.

2. ADDITIONAL LIMITATIONS. You may not reverse engineer, decompile, or
disassemble the Product, except and only to the extent that it is expressly permitted
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by applicable law notwithstanding this limitation. You may not rent, lease, lend or
transfer the Product, or host the Product for third parties. The Product is licensed as a
single integral product; its component parts may not be separated for use on more
than one computer. The Product may include copy protection technology to prevent
the unauthorized copying of the Product or may require original media for use of the
Product on the computer. It is illegal to make unauthorized copies of the Product or to
circumvent any copy protection technology included in the Product. The software may
not be resold either by You or a third party customer without the prior written
permission of Foxit. All rights not expressly granted to You are retained by Foxit.

2.1. Third Party Software. The Product may contain third party software that
Foxit can grant sublicense to use and which is also protected by copyright law
and other applicable laws.

3. EDUCATIONAL USE. If the Product You have received with this Agreement is an
Educational Software Bundle (where the Product is received by virtue of Your
participation in a Foxit program designed for educational or research institutions, or is
provided by Foxit to You under some other arrangement), You are not entitled to use
the Product unless You are an employee or student of such educational institution.
Educational Software Products may be used for educational and research purposes
only. Commercial and general production use of Educational Software Products are
specifically prohibited. The Product is provided under a Single-Use Term License as
described above. You may install one copy of the Product on one desktop computer in
a designated computer used for educational purposes under Your license agreement.
Your Educational license is granted for a period of one year, unless stated otherwise,
from when the Product license keys are made available to You. Your Educational
license entitles You to email and telephone support for up to two designated
employees and product upgrades during the term of Your license. You grant Foxit the
right to use material created under such license for marketing and advertising
purposes.

4. SUPPORT, MAINTENANCE, AND UPGRADE PROTECTION TERMS AND
CONDITIONS.

4.1. Term of Maintenance. Foxit agrees to provide Maintenance (as defined
herein) to You pursuant to the terms and conditions set forth herein provided
that You pay the Maintenance Fee for each Product for which Maintenance is
desired and as further described in Section 4.4 below. Maintenance will be
provided for a period of one year, unless otherwise agreed to by the parties in
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writing, from the date of purchase of the Product (the “Initial Support and
Maintenance Term”), and with renewals, annually from the expiration date of
the prior Support and Maintenance Term. Failure to renew annual
maintenance may result in You having to purchase a new license in order to
receive future versions of software and associated ongoing support and
maintenance.

4.2.1. Maintenance Services. In exchange for the Maintenance Fee, Foxit
agrees to provide to You during the term of this Agreement support and
maintenance (collectively "Maintenance") as follows:

4.2.1.1. Support: Foxit will provide email and telephone support to You for
current versions of the Product. Foxit will investigate all of Your questions
and problems promptly. You agree to provide adequate information to
Foxit to assist in the investigation and to confirm that any problems have
been resolved. Foxit does not provide guaranteed response time but will
make good faith effort to answer emails and voice mails within twenty-four
(24) hours or less during weekdays, excluding holidays.

4.2.1.2. Maintenance: Foxit will supply to You, at no additional charge,
any improvements, upgrades, or maodifications to the Product that Foxit
makes generally available. Any such improvements, upgrades, or
modifications shall become part of the Product for all purposes of this
Agreement.

4.2.1.3. You acknowledge and agree that the Maintenance to be provided
by Foxit hereunder is limited to the most current version of the Product
and the immediately preceding version.

4.2. Term of Upgrade Protection. Foxit agrees to provide Upgrade Protection
(as defined herein) to You pursuant to the terms and conditions set forth herein
provided that You pay the Upgrade Protection Fee for each Product for which
Upgrade Protection is desired and as further described in Section 4.4 below.
Upgrade Protection will be provided for a period of one year, unless otherwise
agreed to by the parties in writing, from the date of purchase of the Product
(the “Initial Upgrade Protection Term”), and with renewals, annually from the
expiration date of the prior Upgrade Protection Term. Failure to renew annual
Upgrade Protection may result in You having to purchase a new license in
order to receive future versions of software and associated ongoing Upgrade
Protection.

4.3. Exclusions. Foxit’s obligation to provide Support is contingent upon proper

use of the Product and full compliance with this Agreement. Moreover, Foxit
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shall be under no obligation to provide Support should such services be
required due to (a) failure to operate the Product within the systems
requirements provided for the Product (b) any modification or attempted
modification of the Product by You or any third party or (C) Your failure or
refusal to implement Product changes recommended by.

4.4. Consideration. In payment of the Support, Maintenance and Upgrade
Protection services to be provided by Foxit hereunder, You shall pay Foxit, or
its authorized agent, the applicable fee for the Initial Support, Maintenance
and Upgrade Protection Term as indicated on the related invoice, receipt,
purchase order, or other ordering document ("Support, Maintenance and
Upgrade Protection Fee"). At the end of the Initial Support, Maintenance and
Upgrade Protection Term, or any subsequent Support, Maintenance and
Upgrade Protection Term, You may renew patrticipation in Support,
Maintenance and Upgrade Protection services for additional annual term(s)
provided You (a) are current on all payments due to Foxit and (b) pay Foxit, or
its authorized agent, the applicable renewal fee, which Foxit, or its authorized
agent, shall invoice prior to the end of the preceding term, unless terminated
by You at least 30 days prior to the expiration of the then current Support,
Maintenance and Upgrade Protection Term. The Support, Maintenance and
Upgrade Protection Fee for renewal shall be equal to the Support,
Maintenance and Upgrade Protection Fee for the immediate preceding annual
term plus an increase by a percentage not to exceed the Consumer Price
Index (CPI), as published by the U.S. Department of Labor. In addition,
Support, Maintenance and Upgrade Protection shall be discontinued for any
and all subsequent Support, Maintenance and Upgrade Protection Terms for
which You fail to pay Foxit the invoice within ten (10) days after the prior
Support, Maintenance and Upgrade Protection expiration date.

4.5. Exceptions. For use of the Product or a Beta Software Product, only the
Maintenance Services and Exclusions paragraphs of this section apply. For
use of the Product under Educational Use terms, the Maintenance Services
and Exclusion paragraphs apply as long as You pay for the maintenance
period defined under Your Single-Use Term License.

5. PAYMENT TERMS. Unless explicitly set forth in this Agreement, all fees and other
amounts due under this Agreement are non-cancelable and non-refundable. Unless

otherwise agreed to by the parties, You shall pay all fees or amounts within 30 days of

the date of the invoice. A late fee shall be charged on any overdue amounts and any

other fees and expenses not paid as provided under this Agreement at the rate of one
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and one-half percent (1%2%) per month, or the highest rate allowable under applicable
law, whichever is less, commencing with the date payment was due.

6. TAXES. The fees and all other amounts due as set forth in this Agreement are net
amounts to be received by Foxit, exclusive of all taxes, duties, and assessments,
including without limitation all sales, withholding, VAT, excise, ad valorem, and use
taxes (collectively, the “Taxes”), and are not subject to offset or reduction because of
any Taxes incurred by You or otherwise due as a result of this Agreement. You shall
be responsible for and shall pay directly, any and all Taxes relating to the
performance of this Agreement, provided that this paragraph shall not apply to taxes
based solely on Foxit's income.

7. CONSENT TO USE OF DATA. If Foxit provides any support services to You, You

agree that Foxit and its affiliates may collect and use all information You provide as a
part of any such support services related to the Product. Foxit agrees not to use this

information in a form that personally identifies You.

Collection of this information occurs in accordance with the Foxit Privacy Policy
(http://www.foxitsoftware.com/privacy.php)

8. INTELLECTUAL PROPERTY RIGHTS. Subject to the license grant hereunder, all
right, title and interest in and to the Product, the accompanying printed materials, and
any copies of the Product are owned by Foxit and its licensors.

9. EXPORT RESTRICTIONS. You acknowledge that Product is of U.S. origin. You
agree to comply with all applicable foreign, federal, state and local laws and
regulations governing Your use of the Product. Without limiting the foregoing, in the
event that this Agreement permits export of the Product outside the U.S., You shall be
solely responsible for compliance with all applicable U.S. export laws, rules, and
regulations. The Product is subject to the U.S. Export Administration Regulations and
other U.S. law, and may not be exported or re-exported to certain countries (currently
Cuba, Iran, Libya, North Korea, Sudan and Syria) or to persons or entities prohibited
from receiving U.S. exports (including those (a) on the Bureau of Industry and
Security Denied Parties List or Entity List, (b) on the Office of Foreign Assets Control
list of Specially Designated Nationals and Blocked Persons, and (c) involved with
missile technology or nuclear, chemical or biological weapons).

10. WARRANTY

10.1. Warranty. Foxit warrants that for a period of 90 days from the date of
delivery (“Warranty Period”), under normal use, the Product will perform
substantially in conformance with the specifications published in the
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Documentation. During such period, and as the sole obligation of Foxit and
Your sole remedy under the warranty in this Section, if You provide written
notice of Foxit’s failure to comply with the above warranty, Foxit will use
reasonable commercial efforts to correct such nonconformity in the Product as
in accordance with the terms of the Maintenance and Support Policy. In
addition, if Foxit determines it is not commercially reasonable to correct the
nonconformity, Foxit may elect to terminate the license to such Product, upon
which termination Licensee will promptly return to Foxit all such copies of such
Product. Upon receipt of the Product from Licensee, Foxit will return to
Licensee all license fees (and any unused support fees) paid to Foxit by You
for such Product. This warranty set forth above does not apply to, and Foxit
shall have no obligation with respect to, any non-conformity arising as a result
of (i) use of the Product other than as specified under this Agreement and the
related Documentation; (ii) any modification or alteration of the Product
performed other than by Foxit or its agents, or (iii) transfer of the Product to
any computer system other than the ones on which Product is authorized to be
stalled, except as permitted in this Agreement.

10.2. Disclaimer. Other than the warranty set forth in Section 10.1 above, and
to the maximum extent permitted by applicable law, Foxit, its authorized
resellers and their subsidiaries provides the Product and any support services
related to the Product ("Support Services") AS IS AND WITH ALL FAULTS,
and hereby disclaim all other warranties and conditions, either express,
implied or statutory, including, but not limited to, any implied warranties, duties
or conditions of merchantability, of fithess for a particular purpose, of accuracy
or completeness of responses, of results, of workmanlike effort, of lack of
viruses, and of lack of negligence, all with regard to the Product, and the
provision of or failure to provide support services.

11. LIMIT OF LIABILITY AND EXCLUSION OF INCIDENTAL, CONSEQUENTIAL
AND CERTAIN OTHER DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL FOXIT, ITS AUTHORIZED RESELLERS
OR THEIR SUBSIDIARIES BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
INDIRECT, PUNITIVE OR CONSEQUENTIAL DAMAGES WHATSOEVER
(INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF PROFITS OR
CONFIDENTIAL OR OTHER INFORMATION, FOR BUSINESS INTERRUPTION,
FOR PERSONAL INJURY, FOR LOSS OF PRIVACY, FOR FAILURE TO MEET ANY
DUTY INCLUDING OF GOOD FAITH OR OF REASONABLE CARE, FOR
NEGLIGENCE, AND FOR ANY OTHER PECUNIARY OR OTHER LOSS
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WHATSOEVER) ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF
OR INABILITY TO USE THE PRODUCT, THE PROVISION OF OR FAILURE TO
PROVIDE SUPPORT SERVICES, OR OTHERWISE UNDER OR IN CONNECTION
WITH ANY PROVISION OF THIS LICENSE, EVEN IN THE EVENT OF THE FAULT,
TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY, BREACH OF CONTRACT
OR BREACH OF WARRANTY OF FOXIT, EVEN IF FOXIT HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.

11.1. LIMITATION OF LIABILITY AND REMEDIES. Notwithstanding any
damages that You might incur for any reason whatsoever (including, without
limitation, all damages referenced above and all direct or general damages),
the entire liability of Foxit, its resellers and their subsidiaries under any
provision of this License and Your exclusive remedy for all of the foregoing
shall be limited to the amount actually paid by You for the Product. The
foregoing limitations, exclusions and disclaimers shall apply to the maximum
extent permitted by applicable law, even if any remedy fails its essential
purpose.

11.2. NOTICE TO U.S. GOVERNMENT END USERS

11.3. For contracts with agencies of the Department of Defense, the
Government’s rights in: (1) commercial computer software and commercial
computer software documentation shall be governed, pursuant to 48 C.F.R.
227.7201 through 227.7202-4, by Foxit’'s standard commercial license(s) for
the respective product(s); (2) software and software documentation other than
commercial computer software and commercial computer software
documentation shall be governed by 48 C.F.R. 252.227-7014; (3) technical
data for commercial items other than software or software documentation shall
be governed by 48 C.F.R. 252.227-7015(b); and (4) technical data for
non-commercial items other than software or software documentation shall be
governed by 48 C.F.R. 252.227-7013.

11.4. For contracts with U.S. Government agencies other than the Department
of Defense agencies, the Government’s rights in: (1) commercial computer
software and commercial computer software documentation shall be governed,
pursuant to 48 C.F.R. 2.101 and 12.212, by Foxit’s standard commercial
license(s) for the respective product(s); (2) software and software
documentation other than commercial computer software and commercial
computer software documentation shall be governed by 48 C.F.R. 52.227-14,
Alternative Ill; and (3) technical data other than software and software
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documentation shall be governed by 48 C.F.R. 52.227-14 including, where
applicable Alternatives | or II.

12. GENERAL. This Agreement will be governed by and construed in accordance with
the laws of the State of California excluding that body of laws known as conflicts of
law. The United Nations Convention on Contracts for the International Sale of Goods
will not apply. Any legal action or proceeding arising under this Agreement will be
brought exclusively in the federal or state courts located in San Jose, California and
the parties hereby irrevocably consent to the personal jurisdiction and venue therein.
You may not assign this Agreement or any right or interest hereunder, by operation of
law or otherwise, without Foxit's express prior written consent. Any attempt to assign
this Agreement, without such consent, will be null and of no effect. Subject to the
foregoing, this Agreement will bind and inure to the benefit of each party's successors
and permitted assigns. Except as expressly set forth in this Agreement, the exercise
by either party of any of its remedies under this Agreement will be without prejudice to
its other remedies under this Agreement or otherwise. If for any reason a court of
competent jurisdiction finds any provision of this Agreement invalid or unenforceable,
that provision of the Agreement will be enforced to the maximum extent permissible
and the other provisions of this Agreement will remain in full force and effect. All
notices or approvals required or permitted under this Agreement will be in writing and
delivered by confirmed facsimile transmission, by overnight delivery services, or by
certified mail, and in each instance will be deemed given upon receipt. All notices or
approvals will be sent to the addresses set forth in the applicable ordering document
or invoice or to such other address as may be specified by either party to the other in
accordance with this section. Neither party will be responsible for any failure or delay
in its performance under this Agreement (except for any payment obligations) due to
causes beyond its reasonable control, including, but not limited to, labor disputes,
strikes, lockouts, shortages of or inability to obtain labor, energy or supplies, war,
terrorism, riot, or acts of God. The failure by either party to enforce any provision of
this Agreement will not constitute a waiver of future enforcement of that or any other
provision. This Agreement, including Foxit’s support and maintenance services terms
constitutes the entire and exclusive agreement between the parties concerning its
subject matter and supersedes all prior written and oral understandings and
agreements between the parties regarding its subject matter. The terms and
conditions contained in any customer purchase order or other ordering document that
are inconsistent with or in addition to the terms and conditions of this Agreement are
hereby rejected by Foxit and will be deemed null and of no effect.
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13. COMPLIANCE WITH LICENSES. If You are a business, company or organization,
You agree that upon request from Foxit or its authorized representative You will within
thirty (30) days fully document and certify that use of any and all Foxit Products at the
time of the request is in conformity with Your valid licenses from Foxit.

14. DISCONTINUING OR MODIFYING SERVICES. You acknowledge that Foxit has
the right to discontinue the manufacture and development of any of the Product and
the support for that Product, in its sole discretion at any time, including the distribution
of older Product versions, provided that Foxit agrees not to discontinue the support for
that Product during the current annual term of this Agreement, subject to the
termination provisions herein. Notwithstanding the foregoing, if Foxit discontinues the
manufacture and support for a particular Product, Support for any remaining Products
covered by this Agreement shall not be adversely affected. Foxit reserves the right to
alter the Support, in its sole discretion but in no event shall such alterations result in:
(a) diminished support from the level of support set forth herein; (b) materially
diminished obligations for Foxit; or (c) Your materially diminished rights.

15. MARKETING. You agree that You and Your business, company, or organization
may be identified as a customer of Foxit and Foxit may refer to You and your business,
company, or organization by name and logo, and Foxit may briefly describe

Licensee’s business in Foxit's marketing materials and website.

16. Should You have any questions concerning this License, or if You desire to
contact Foxit for any reason, please call (510) 438-9090.
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Chapter 1 - Overview

Welcome to Foxit PDF IFilter - a professional tool that helps you to index PDF files.

Foxit PDF IFilter is an application that extracts the contents, properties, bookmarks, form,
annotations and attachments from PDF documents, indexes them, and returns the
indexed results to the search engine so that users can search PDF documents with
keywords.

Foxit PDF IFilter supports PDF 1.7 specification and can be used in many Microsoft
search engines, such as Windows Indexing Service, MSN Desktop Search, Internet
Information Server, SharePoint Portal Server, Windows SharePoint Services (WSS), Site
Server, Exchange Server, SQL Server, and all other products based on Microsoft Search
technology. With Foxit PDF IFilter, all these search engines can find PDF files with ease.

Why PDF IFilter?
PDF IFilter is necessary for several reasons:

» Microsoft creates and maintains office file formats, such as .doc, .xIs, .ppt, etc.
However, many other file formats are created and maintained by other companies.
For example, PDF was created by Adobe.

» With the advantages of security, reliability and accessibility, PDF is now being used
by more and more people all over the world.

» PDF IFilter is a plug-in that allows Microsoft search engines to index PDF files so that
they become searchable. Without an appropriate PDF IFilter, contents of a PDF file
cannot be indexed.

Why Foxit PDF IFilter?

Foxit PDF IFilter is favored by a large number of governments and well-known companies
because of the following reasons:

» Foxit PDF IFilter helps to do PDF indexing, which makes finding information much
easier.

» Foxit PDF IFilter supports multi-threading and makes full use of multi-CPU/core in a
server.

Foxit PDF IFilter supports native 64-bit code.
Smaller and faster than other PDF IFilters.

Supports twelve languages. Please go to Language Support part for details.
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How Foxit PDF IFilter works?

Foxit PDF IFilter acts as a plug-in for full-text search engines. A search engine usually
works in two steps:

Step 1, the search engine goes through a designated place, e.g. a file folder or a
database, and indexes all documents or newly modified documents, including PDF
documents, in the background and creates internal data to store the indexed result.

Step 2, a user specifies some keywords for search and the search engine looks up the
indexing result and responds to the user with all the documents that contain the keywords.

During Step 1, the search engine looks in the windows registry for appropriate IFilter
implementations and uses those filters for indexing. It filters out embedded formatting and
extracts text from the document and returns the result. Foxit PDF IFilter is one such
implementation. Further information about the IFilter specification can be found on the
Microsoft Web site.

Key Benefits

Integrates with existing operating systems and tools within your company.

Provides an easy solution to search within PDF documents located on the local
computer, local network, and/or intranet.

Greatly increases your ability to accurately locate information.

Much smaller and faster than PDF IFilters offered by other vendors.

Supports Chinese/Japanese/Korean PDF documents.

Supports native 64-bit code.

Supports searching and indexing PDFs by extracting subject, author and content of
annotations.

»  Supports multi-threading and takes full use of multiple-CPU in a server.

v

v

vV V V V V
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Chapter 2 - Getting Started

Installing Foxit PDF IFilter

To install Foxit PDF IFilter on your environment, please first download the current version
with the link provided in the sales email after purchasing the license. Also, you could apply
for 30-day trail from Foxit Website (http://www.foxitsoftware.com/products/ifilter/).

There are two packs of Foxit PDF IFilter, which are respectively for 32bit OS and 64bit OS.
Please get the proper one and install it as follows.

1. Stop all the appropriate clients.

2. Uninstall any previous version of Foxit PDF IFilter if installed.

3. Launch the installer of Foxit PDF IFilter and follow the step to finish the installation.
4. Restart all the appropriate clients after finishing the installation.

Notes:

» More installation steps are required for SQL, WSS and Moss environments. Please
refer to the corresponding chapter.

» Foxit PDF IFilter item will appear in program list of Control Panel after installation.

Foxit PDF IFilter has no user interface.

» The installer will unzip an add-on called fpdfcjk.bin to the installation folder. The
add-on will help you to index PDF documents containing Chinese/Japanese/Korean
characters.

A\

Configuring Foxit PDF IFilter

There are five registry items for configuring Foxit PDF IFilter. They are under the directory:
“‘HKEY_LOCAL_MACHINE\SOFTWARE\Foxit Software\Foxit PDF IFilter”.

FilterAnnotation[REG_DWORD] - sets the value to specify whether to filter out
annotations. O represents no and other values represent yes.

FilterBookmarks[REG_DWORD] - sets the value to specify whether to filter out
bookmarks. O represents no and other values represent yes.

FilterAttachFile [REG_DWORD] - sets the value to specify whether to filter out
attachments. O represents no and other values represent yes.

LogLevel [REG_DWORD] - sets the log level. Value can be from 0 to 3.

0 - no output
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1 - Error log only. Includes error information when errors happen, and stack
message when the application crashes.

2 - Simple log which only includes the main calling functions and returned values.
3 - Detailed log which includes specific information such as date and chunk.
LogFilePath [REG_SZ] - sets the output path of log file.
Note:

The default setting in Foxit PDF IFilter is to filter out bookmarks. Restart the application if
you made any changes to the registry.

Updating Foxit PDF IFilter

To update Foxit PDF IFilter to the current version, it asks to uninstall the old one first.
Generally, you do not have to reboot your machine after updating to the
minor/maintenance version.

Foxit PDF IFilter consists of a core layer and an installation layer. When you upgrade the
installation layer, you do not need to re-do a full index. But when you upgrade the core
layer, you should decide whether or not to rebuild index on your computer according to the
importance of the updates by checking the new features on Foxit Website.

Uninstalling Foxit PDF IFilter

To remove the old version of Foxit PDF IFilter, please uninstall it from Control Panel or
with the help of the installer as below:

1. From Control Panel:

« Choose Start > Control Panel > Add or Remove Programs.
+ Choose the “Foxit PDF IFilter” item and then click “Remove” button to uninstall it.

2. From the installer:

« Double-click the Foxit PDF IFilter.msi setup file that was used to install Foxit PDF
IFilter.

+ Inthe Foxit PDF IFilter dialog box, select Remove Foxit PDF IFilter.

+ Click the Finish button to uninstall it.
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Chapter 3 - Foxit PDF IFilter for
SharePoint/MOSS

Foxit PDF IFilter can help search text in PDF files. After installing Foxit PDF IFilter, you
should upload your PDF documents and perform a full crawl with Microsoft Office
SharePoint Server (MOSS) before you start searching.

You don’t have to do full crawls every time you add new PDF files. You may schedule the
incremental crawls for all the new ones.

Working in SharePoint 2010

Installing Foxit PDF IFilter

Foxit PDF IFilter has two versions respectively for 32-bit Windows and 64-bit Windows.
You can choose one of them to install into your machine according to your system
requirements. Before installing Foxit PDF IFilter, please note that Microsoft Office
SharePoint Server has been installed successfully.

To install Foxit PDF IFilter, please do the following:

« Download Foxit PDF IFilter from Foxit Website (http://www.foxitsoftware.com) onto
the machine where you wish to install it.

» Stop the IS Admin service: Start > Administrator Tools > Services(Local) > 1IS Admin
Service > Stop. Close window.

« Run the Foxit PDF IFilter Setup program to install the filter on the server.

« Download PDF icon from http://www.foxitsoftware.com/pdf/ifilter/pdficon.gif.

« Copy the downloaded .GIF file to "Drive:\Program Files\Common Files\Microsoft
Shared\Web Server Extensions\14\Template\Images".

+ Edit the file “Drive:\Program Files\Common Files\Microsoft Shared\Web server
extensions\14\Template\XmN\DOCICON.XML”:

1. Right-click DOCICON.XML file > click Open With > select Notepad.

2. Add an entry for the .pdf extension. For example, where ICPDF is the name of
the .gif file:

<Mapping Key="pdf" Value="pdficon.qgif"/>
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-Ioix

File Edit Format View Help

<?xm] version="1.0" encoding="utf-8"7> =
<DoCIcons>

<ByProgID>
<Mapping Key="Excel.Sheet" value="ichtmxls.gif" EditText="Microsoft Excel" Openc
<Mapping Key="FrontPage.Editor.Document"” value="ichtmfp.gif" EditText="Microsoft
<Mapping Key="InfoPath.Document” value="icxddoc.gif" EditText="Microsoft InfoPat
<Mapping Key="InfoPath.Document.2" value="icxddoc.gif" EditText="Microsoft InfoP
<Mapping Key="InfoPath.Document.3" value="icxddoc.gif" EditText="Microsoft InfoP
<Mapping Key="InfoPath.Document.4" value="icxddoc.gif" EditText="Microsoft InfoP
<Mapping Key="0DC.Cube" value="icodcc.qgif" EditText="Microsoft Excel"” OpenContro-
<Mapping Key="0ODC.Database" value="icodcd.qgif" EditText="Microsoft Excel" Openco
<Mapping Key="0DC.Table" value="icodct.gif"” EditText="Microsoft Excel” OpenContr
<Mapping Key="Onenote.Notebook" Va1ue="1cnotebk.png" EditText="Microsoft OneNote
<Mapping Key="PowerpPoint.slide" Va]ue="1chtmppt.gi " EditText="Microsoft PowerPo
<Mapping Key="Publisher.Document” value="ichtmpub.gif" EditText="Microsoft Publi
<Mapping Key="sharepoint.Documentset” value="icdocset.gif"/>
<Mapping Key="SharePoint.webPartPa?e.Document” value="icsmrtpg.gif"” EditText="Mi
<Mapping Key="visio.webDrawing” value="icvdw.gif" EditText="Microsoft visio" Ope
<Mapping Key="word.Document" Value="1ichtmdoc.gif" EditText="Microsoft word" oOpen
<Mapping Key="XDocs.Document" value="icxddoc.gif" EditText="Microsoft InforPath"
<Mapping Key="Sharepoint.Link" value="DOCLINK.GIF"/>
<Mapping Key="SharePoint.SearchadminReport” value="icsadrep.gif" EditText="Micro

</ByProgIp>

<ByEXxtension>

(QMapping Key="pdf" value="pdficon.gif"/> ]

<Mapping Key="accdb" value="icaccdb.gif" EditText="Microsoft Access" OpencContro
<Mapping Key="accdt" value="icaccdb.qgif"/>
<Mapping Key="accdc" value="icaccdb.gif"/>

<Mapping Key="accde" value="icaccde.qgif" EditText="Microsoft Access" OpencContro
<Mapping Key="accdr" value 1caccde.$if" EditText="Microsoft Access" OpencContro
<Mapping Key="asax" value="icasax.gif" opencontrol=""/>

<Mapping Key="ascx" value="icascx.gif" EditText="Microsoft Sharepoint Designer"
<Mapping Key="asmx" va1ue=”icasmx.?if" opencontrol=""/>

<Mapping Key="asp" value="ichtm.gif" opencontrol=""/>

<Mapping Key="aspx" value="ichtm.gif" EditText="Microsoft sharepoint Designer" 0
<Mapping Key="bmp" value="4icbmp.gif"/>

<Mapping Key="cat" value="iccat.gif" openControl=""/> e

4 | >y

1. Onthe File menu, click Save, and then quit Notepad.

Note: This directly changes the icons shown on the search result. Make sure this change takes effect in
the appropriate server where search results are displayed i.e. any web front end (WFE) that supports

user interfacing.

« Perform an iisreset:

1. Click Start > Run > type “cmd” in the Open line> click OK > type “iisreset” at the
command prompt > hit Enter.

E:'\ WINDOWS ) system32 cmd.exe

Microsoft Windows [Uersion 5.2.37981
(C» Copyright 1985-2883 Microsoft Corp.

E:“Documents and Settings“Admin istrato

Attempting stop...

Internet services successfully stopped
Attempting start...

Internet services successfully restarted

E:“Documents and Settings“Administrator>_

2. Close the window.
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« Stop and start the Sharepoint Search Service by running the following commands:
1. net stop spsearch4
2. net start spsearch4
3. net stop osearchl14
4. net start osearch14

Note:

If you changed the settings for IFilter in the configurable registry, please perform the
following commands in the command prompt window:

. lisreset

. het stop spsearch4
. het start spsearch4
. het stop osearch14
. het start osearch14

a b~ W DN B

Indexing PDFs

To index PDF files on your computer, please do the following:

e Add the .pdf file type to the index list:

1. Gotothe Search Service Application: Search Administration page, in the
Crawling section, click File Types.

2. Click New File Type > type “pdf” in the File extension field > click OK.
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> Search Service Application: Manage File Types dows Internet Explorer

v

7
w \f | Search Service Application: Manage File Types

.| http:/fwin-dhbouvs 1vcz: 1000/_admin/search/managefiletypes.aspx?appid ={5401f003-5301-4800-a0b4-c0893542f4ce}

. SRarePoint 2010

administration
Search Administration

Farm-Wide Search
Administration

Crawling
Content Sources

Crawl Rules

Crawl Log

Server Name Mappings
Host Distribution Rules
File Types

Reset All Crawled
Content

Crawler Impact Rules

Queries and Results
Authoritative Pages

Federated Locations
Metadata Properties
Scopes

Search Result Removal

Central Administration » Search Service Application: Manage File Types

Use this page to specify file types to incude in the content index.

= New File Type

Icon File name extension
ascx
@’] asp
@ aspx
csv
@_1 doc
@] docm
@_J docx
@J dot
a eml
exch
@ htm
@ html
jhtml

File type

asp document

ASP.NET Server Page
csv document

doc document

docm document

docx document

dot document

Internet E-Mail Message
exch document

HTML Document

HTML Document

jhtml| document

Site Actions v
SCOpes

Search Result Removal

Reports
Administration Reports

Web Analytics Reports

@ html

jhtml
isp
mht

mhtml

B &

HTML Document
jhtml document
jsp document
MHTML Document
MHTML Document
msg document
mspx document
nsf document
Internet News Message
odc document
odp document
ods document
odt document

one document

Foxit PDF Document ]

odt
an one
( &) pdf
php
] ppt
| pptm
& pPtx
lﬁ] pub
5 tif
= tiff

php document
ppt document
pptm document
pptx document
pub document
tif document

tiff document

» Upload a PDF file, and perform a Full Crawl on the Search content indexes:
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1. Go to the Shared Documents, and click Add new document.

SharePoint2010 » Shared Documents : All Documents ~

Share a document with the team by adding it to this document library.

Home
Documents [T Type Name
Stte:Pages 2 000003_Czech_02042CZ & ew
Shared Documents
_ 2, 000003_French_001_actus & Hew
@ FoxitPDFIFilter1.0forSQLServer2005_manual & New
Lists 3
2] FoxitPDFIFilter1.0forWDSandVistaSearch_Manual & vew
Calendar =
Tasks 4 Add new document
Discussions

Team Discussion

18] Recycle Bin
(3 Al site Content

2. Click the Browse button to upload a PDF document and click OK.

Upload Document

Upload Document Name:
Browse to the document you |C:\Users\Administrator\Desktop\000003_f = Browse... I

intend to upload.

v Overwrite existing files

OK Cancel

3. In Edit page, you can give the title, keywords, if you like, to your uploaded PDF
file. Click the Save button.
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Shared Documents - 000003_French_001_actus.pdf

ﬂ I .’ s & Cut x
Save Cancel Paste Delete
Item

Commit Clipboard Actions

¥ The document was uploaded successfully. Use this form to update the properties of the document.

Name *

|000003_French_001_actus .pdf
Title |French
Managed Keywords |d|~:~neyland

Created at 12/1/2009 12:28 AM by System Account
Last modified at 12/1/2009 7:26 PM by System Account

Save Cancel

4. When you are done, you will be returned to the Documents page where you will
see that your PDF file has been uploaded.

5. Return to the Search Application: Search Administration home page, in Crawling
section, click Content Sources link.

6. On the Manage Content Sources page, open the content source’s context menu
by left-clicking the down arrow and select Start Full Crawl to index all files. This
will start the indexing process.

. SRarePoint 2010

Administration
Search Administration

Farm-Wide Search
Administration

Crawling
Content Sources

Crawl Rules

Crawl Log

Server Name Mappings
Host Distribution Rules
File Types

Reset All Crawled
Content

Crawler Impact Rules

Queries and Results
Authoritative Pages
Federated Locations
Metadata Properties
Scopes

Search Result Removal

Central Administration » Search Service Application: Manage Content Sources

Use this page to add, edit, or delete content sources, and to manage cranls.

=i New Content Source (2] Refresh  Start all crawls

Type  Name Status  Current crawl duration Last crawl duration

b

[Local Sharepoint sites Idle 00:05:32
Edit

View Crawl Log

Start Full Crawl

Start Incremental Crawl

Last crawl completed Next Full Crawl Next Incremental Crawl

12/1/2009 1:47 AM None None

7. (Optional) To start an incremental crawl, please open the content source’s context
menu by left-clicking the down arrow and select Start Incremental Crawl.

« View Crawl Logs.
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1. Return to the Shared Documents.
2. Right-click the PDF document you have uploaded > choose Properties.

3. Select the address (URL) of the PDF file except [filename.pdf] > right-click the
selected area > choose Copy.

properties x
General I

000003 _French_001_actus pdf

Protocol: HyperText Transfer Protocol
Type: Foxit PDF Document

Address:

ttp://win-dhbouvs 1vcz/Shared %
{URL)

(Haftel =g 3/000003_French_001_actus pdf

4. Go to the Manage Content Sources page, open the content source’s context
menu by left-clicking the down arrow and select View Crawl Log

M o
&, SHrePomrzom Central Administration » Search Service Application: Crawl Log - Content Source

IAdministration

Search Administration Content Source| Host Name URL  Crawl History  Error Message

Farm-Wide Search
Administration
Use this page to view a summary of items crawled per content source.

Crawling

e Content Source Successes Warnings Errors Top Level Errors
Crawl Rules Local SharePoint sites 58 1 0 0
Crawl Log

Server Name Mappings

Host Distribution Rules

5. In Crawl Log page, click URL, paste the URI to URL or Host name >click
search button. When you’re done, you can see the whole URL of the uploaded
PDF file appear on the list.

Page 24



F()Xlt Foxit PDF IFilter Server

Search Administration  Content Source  Host Name Crawl History  Error Message

Farm-Wide Search
Administration

Use this page to search the crawl logs by content source, URL or host name, To Further narrow the search apply 'Additional Filters',

Crawling Search By
Content Sources ' Content Source
Crawl Rules [an =l

Crawl Log & URL or Host name
Server Name Mappings Itp://win—dhbouvs1vcz/Shared“/o20Documents Exact Match
Host Distribution Rules

File Types ‘Additional Filters
Reset All Crawled status  [All =]
Content
Message: [All ~|
Crawler Impact Rules
Complete message: All
lQueries and Results startTime [ #[1zam =] [00 =] EndTime [z an =l [oo =]

Authoritative Pages

Federated Locations

Metadata Properties

Scopes Results returned - 63 Items
Search Result Removal Item ID URL Content Source Last Time Crawled
Reports o 62 http://win-dhbouvsivcz/shared% Local SharePoint sites

20documents/forms/dispform.aspx?id=9
Deleted by the gatherer

Administration Reports

W Analytics Re¢
ehpralyicsReports; | gy 51 http://win-dhbouvs1vcz/sitepages/home.aspx Local SharePoint sites 12/1/2009 12:30:59 AM
i

E 59 http://win-dhbouvs1ivcz/shared% Local SharePoint sites 12/1/2009 12:30:59 AM
20documents/forms/dispform.aspx?id=14
Crawled

L] 56 http://win-dhbouvsivcz/shared% Local SharePoint sites 12/1/2009 12:30:59 AM
20documents/forms/dispform.aspx?id=13
Feaudad

Searching PDFs

After you finish indexing PDF files, you can start a search to find text within PDF files. Also,
you can search PDF document properties, such as author, title, etc.

To start a search, please perform the following:

+« Gotothe Shared Documents: All Documents page, type the text you want to
search in the search box > hit Enter.

'010 » Shared Documents : All Documents ~
ent with the team by adding it to this document library.

[ FAQ| »
T Type Name Modified Modified By
2] 000003_Czech_02042CZ &tew 12/1/2009 1 AM System Account

(4  000003_French_001_actus &imnew 12/1/2008 7:26 PM

System Account

« You will see your search results. Click to open one of the PDF files.
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‘{j‘J SharePoint2010 » Site Search Results

Home (7]
This Site: SharePoint20, 'l FAQ yel

Expand your search to "All Sites" using the list beside the search box.

1-2 of 2 results A

No refinements available

(2 Foxit PDF IFilter 1.0 for WDS and Vista Search User Manual
Copyright © 2009 Foxit Corporation. All Rights Reserved. ... No part of this document can be

reproduced, transferred, distributed or stored in any format without the prior ... FAQ ...
Authors: System Account;Foxit Corporation Date: 12/1/2009 Size: 1MB
http://win-dhbouvs1vcz/Shared Documents/FoxitPDFIFilterl.0forWDSandVistaSearch_Manual.pdf

(2 Foxit PDF IFilter 1.0 for Microsoft SQL Server 2005 user manual
Copyright @ 2009 Foxit Corporation. All Rights Reserved. ... No part of this document can be
reproduced, transferred, distributed or stored in any format without the prior ... FAQ ...
Authors: System Account;Foxit Corporation Date: 12/1/2009 Size: 423KB
http://win-dhbouvsivcz/Shared Documents/FoxitPDFIFilter1.0forSQLServer2005_manual.pdf

Search results

™ FoxitPDFIFilter1.0forWDSandVistaSearch_Manual.pdf * - Foxit Reader - [FoxitPDFIFilter1.0for

@ File Edit View Comments Forms Tools Help

EBER0 e BEia - BHe -

FoxitPDFIFiterl.0forMOSS_man... | FoxitPDFIFicerl.0forWDSandVis... |

i
s
-

[
g
2

FA

Open one of the search results
Working in Moss 2007
Installing Foxit PDF IFilter

Foxit PDF IFilter has two versions respectively for 32-bit Windows and 64-bit Windows.
You can choose one of them to install onto your machine according to your system
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requirements. Before

installing Foxit PDF IFilter, please note that Microsoft Office

SharePoint Server has been installed successfully.

To install Foxit PDF IFilter, please do the following:

Download Foxit PDF IFilter from Foxit Website (http://www.foxitsoftware.com) onto
the machine where you wish to install it.

Stop the 1IS Admin service: Start > Settings > Control Panel > Administrator Tools >
Services > IS Admin Service > Stop. Close window.

Run the Foxit PDF IFilter Setup program to install the filter on the server.

Download PDF icon from http://www.foxitsoftware.com/pdf/ifilter/pdficon.qgif.

Copy the downloaded .GIF file to "Drive:\Program Files\Common Files\Microsoft
Shared\Web Server Extensions\12\Template\Images".

Edit the file “Drive:\Program Files\Common Files\Microsoft Shared\Web server
extensions\12\Template\ XmN\DOCICON.XML":

1. Right-click DOCICON.XML file > click Open With > select Notepad.

2. Add an entry for the .pdf extension. For example, where ICPDF is the name of

the .qgif file:

<Mapping Key="pdf" Value="pdficon.gif"/>

Il poaconXML - Notepad s -0 x|
File Edit Format View Help
<?xml version="1.0" encoding="utf-8"7>
<DOCICONS>
<ByProgID>
<Mapping Key="Excel.Sheet" value="ichtmxls.gif" EditText="Microsoft Excel" oOpenc
<Mapping Key="FrontPage.Editor.Document” value="ichtmfp.gif" EditText="Microsoft
<Mapping Key="InfoPath.Document” value="1icxddoc.gif" EditText="Microsoft InfoPat
<Mapping Key="InfoPath.Document.2" value="icxddoc.gif" EditText="Microsoft InfoP
<Mapping Key="InfoPath.Document.3" value="icxddoc.gif" EditText="Microsoft InfoP
<Mapping Key="InfoPath.Document.4" value="1icxddoc.qgif" EditText="Microsoft InfoP
<Mapping Key="0DC.Cube" value="icodcc.gif" EditText="Microsoft Excel"” OpenContro-J
<Mapping Key="0DC.Database" value="icodcd.qgif" EditText="Microsoft Excel" Openco
<Mapping Key="0DC.Table" value="icodct.gif"” EditText="Microsoft Excel” openContr
<Mapping Key="Onenote.Notebook" value="icnotebk.png" EditText="Microsoft OneNote
<Mapping Key="PowerpPoint.slide" va1ue=”ichtmppt.gi " EditText="Microsoft PowerPo
<Mapping Key="Publisher.Document” value="ichtmpub.gif" EditText="Microsoft Publi
<Mapping Key="sharepPoint.Documentset” value="icdocset.gif"/>
<Mapping Key="sharepoint.webPartpPage.Document” value="icsmrtpg.gif"” EditText="Mmi
<Mapping Key="visio.webDrawing" value="1icvdw.gif" EditText="Microsoft visio" Ope
<Mapping Key="word.Document" Value="1ichtmdoc.gif" EditText="Microsoft word" oOpen
<Mapping Key="XDocs.Document" value="icxddoc.gif" EditText="Microsoft Inforath”
<Mapping Key="Sharepoint.Link" value="DOCLINK.GIF"/>
<Mapping Key="SharePoint.SearchadminReport” value="icsadrep.gif" EditText="Micro
</ByProgID>
<ByExtension>
(?Mapping Key="pdf" value="pdficon.gif"/>
<Mapping Key="accdb" value="icaccdb.gif" EditText="Microsoft Access" OpenContro
<Mapping Key="accdt" value="icaccdb.gif"/>
<Mapping Key="accdc" value="icaccdb.gif"/>
<Mapping Key="accde" value="icaccde.gif" EditText="Microsoft Access" OpencContro
<Mapping Key="accdr" va1ue="icaccde.2if" EditText="Microsoft Access" Opencontro
<Mapping Key="asax" value="icasax.gif" opencontrol=""/>
<Mapping Key="ascx" value="icascx.gif" EditText="Microsoft SharepPoint Designer"
<Mapping Key="asmx" va]ue="1casmx.?if" opencontrol=""/>
<Mapping Key="asp" value="ichtm.gif" opencontrol=""/>
<Mapping Key="aspx" value="ichtm.gif" EditText="Microsoft sharepoint Designer" 0
<Mapping Key="bmp" value="icbmp.gif"/>
<Mapping Key="cat" value="1iccat.gif" opencontrol=""/>
| | »
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3. On the File menu, click Save, and then quit Notepad.

Note: This directly changes the icons shown on the search result. Make sure this change takes effect in
the appropriate server where search results are displayed i.e. any web front end (WFE) that supports

user interfacing.

« Perform an iisreset:

1. Click Start > Run > type “cmd” in the Open line> click OK > type “iisreset” at the
command prompt > hit Enter.

SWINDOWS' system32 . cmd.exe

Microsoft Windows [Uersion 5.2.37701
(C» Copyright 1985-2803 Microsoft Corp.

E:“Documents and Settings\ﬂdministrato

Attempting stop...

Internet services successfully stopped
Attempting start...

Internet services successfully restarted

E=“Documents and Settings“Administrator>_

2. Close the window.

« Stop and start the Sharepoint Search Service by running the following commands:
1. net stop spsearch
2. net start spsearch
3. net stop osearch
4. net start osearch

You don’t have to do full crawls every time you add some new PDF files. You may
schedule the incremental crawls for all the new ones.

Note:

e Click to check the parts of Updating Foxit PDF IFilter and Uninstalling Foxit PDF

[Filter.
e If you changed the settings for IFilter in the configurable registry, please perform the

following commands in the command prompt window:

. lisreset

. het stop spsearch
. het start spsearch
. het stop osearch

. net start osearch

ga b WO N B
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Indexing PDFs

To index PDF files on your computer, please do the following:

e Add the .pdf file type to the index list:

1. Go to the Shared Service Administration: SharedServices 1 home page, click
Search Settings link> under Crawl Settings click File Types.

2. Click New File Type > type “pdf”’ in the File extension field > click OK.

‘@ Manage File Types - Microsoft Internet Explorer [_[F

Fle Edt Vew Favortes Toos Help ‘ Fi
Qack - ) - (4 2] b | searth S Favorites £ | (0 0 B - @
Address IEhttD:/ﬂsewevZ _layouts/mar o B |Lwnks
Shared Services Administration; Sharedservicesl \elcome System Account = | Fy Site | My Links = | (@
g4 Shared Services Administration: SharedServices1

™= [siee netore—]

shared Services Administration: SharedServicesl > Search Settings > File Types

Manage File Types

Wiew All Site Content

Back to Central Use this page to specify file types to includs in the content index.

Administration

|r=. Mew File Type

Shared Services

Administration Icon File name extension File bype
- SharedServicesl ] ascx ASPNET User Contral
B Recyele i & asp asp documert
& aspr ASP.NET Server Page
doc WordPad Document
i) docm docm document
()] dacx doex document
i} dot dot document
= el Internet E-Mai Message
exch exch document
& htrn HTMIL Document:
& html HTHML Document
hkml ikl document
isp isp document
& wht MHTML Document
3 mhtml MHTHML Document
= msg msq document
mspi mapc document
nsf nsf document
ode & odle document
[Z] pdf POF Docuent ||
php php document:
ot pet dacument
& pRtm pptm document
e ppbx pptx document
e8] pub pub document:
= uf 4 document

0 | &

The PDF file type has been added

+ Upload a PDF file, and perform a Full Crawl on the Search content indexes:
1. Go to the Document Center, and click Documents.

2. Click Upload, and then Upload Document.
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M55 TEST

ﬁﬁ Document Center
MO55 TEST | Document Center | Mews =  Search  Sikes

M35 TEST = Document Cenker > Documenks

=
EET Documents

Wieww All Site Conkent share a document with the team by adding it ko this document librar:,

Site Hierarchy Mew * | Upload | - | Actions = Setkings -

3] Docurments

Upload & document Fram waur

Mall g Upload Document
7] announcements %j

ALP_2007_web

Type
2 Tasks E:'.j 0z compuker ko this library,
1812
f:_"_{ 1ME_Spage
E 1ME_Spane
[ 2350152
[ 340K
(4
(2

errar

3. Click the Browse button to upload a PDF document and click OK. When it has
uploaded, the Documents Edit Item page is displayed. You can give a title, if you like,
to your uploaded PDF file. Click the Check In button.

MOS5 TEST ‘Welcome: Sy

@4 Document Center all Sites =l

MOS5 TEST | Document Center | Mews »  Search  Sites

MOS5 TEST = Document Center = Documents = test > Edit Ikem
Documents: test

¥ The document was uploaded successfully and is checked out bo you, You must fill out any required properties and check it in before other users will be able to access it.

Check In Cancel |
¥ Delete Itern | 7 Spelling... *indicates a required field
Name * [test .pdf
Title 1]
Version: 0.2 Check In Cancel |
Created at 9/28j2007 1:36 &M by System Account

Last modified at 11f20/2007 10:50 AM by System Account

4. When you are done, you will be returned to the Documents page where you will
see that your PDF file has been uploaded.

5. Return to the Shared Service Administration: SharedServices 1 home page,
click Search Settings link> under Crawl Settings click Content sources and crawl
schedules.

6. On the Manage Content Sources page, open the content source’s context menu
by left-clicking the down arrow and select Start Full Crawl! to index all files. This will
start the indexing process.
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Shared Services Administration: Shared3ervices1

gl Shared Services Administration: SharedServices1

Home

Shared Services Administration: SharedServicesl > Search Settings = Content Sources

Manage Content Sources

Wiews Al Site Content

Back to Central Ise this page ko add, edit, or delete content sources, and to manage crawls.,

Administration
=i Mew Content Source | [£] Refresh
Shared Services

Administration Type Marme Stakus
= SharedServices1 ﬁ‘;ﬁ Local Office ShatePaoint Server sites - | Idle

~ Edit

5/ Recycle Bin

Wigt Crawl Log
Start all crawls Start Full Crawi

Stop all crawls Start Incremental Crawl

Resume all crawls Resume Crawl

Pause all crawls Pause Crawl
Skop Crawl

Delete

7. (Optional) To start an incremental crawl, please open the content source’s context
menu by left-clicking the down arrow and select Start Incremental Crawl.

View Crawl Logs.

1. Return to the Document Center, and click Documents.

2. Right-click the PDF document you have uploaded > choose Properties.

3. Select the address (URL) of the PDF file except [filename.pdf] > right-click the

selected area > choose Copy.

Properties

General |

test. pdf

Protocaol.  HyperTest Transfer Protocal
Type: POF Docurment

Ftalu 2zl A cerver 2003/ D oce/D ocuments JiER )
(URL]

4. Go to the Manage Content Sources page, open the content source’s context
menu by left-clicking the down arrow and select View Crawl Log > paste the URL
to Find URLs that begin with the following hostname/path field > click the Filter
button.
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Shared Services Administration: Shared3ervices1

§dl shared Services Administration: SharedServices1

-

Shared Services gdministration: SharedServicesl = Sear

Crawl Log

Wigw All Sike Content

Find URL [lowing hostname/path:

Back to Central

Administration http:IIserverEDDSIDDcsIDDcummp
Shared Services Conkent Sours
Administration

| Local Office SharePoint Server sites -]

= Shared3ervicesl

5. When you’re done, you can see the whole URL of the uploaded PDF file appear in
the Crawl Log list.

#48 shared Services Administration: SharedServices1

pfiemey)

Shared Services Administration: SharedServicesl = Search Settings = Hostname Su

Crawl Log

Wiew All Sike Content
Back to Central Find URLs that begin with the Following hostnamepath: Show ressages ocourring lat
Administration |http:,I',l'serverzljDS,I'D-:cs,I'Dncuments,l' |

Shared Services Conkent Sources Status Twpe

Gy minelin |L0cal Cffice SharePoint Server sites | |.¢\II

= SharedServicesl

5] Recycle Bin ‘ Crawled Content Status - 174 Items: 171 Successes, O Errors, 3 Warnings

= Yiew by hostname URL

= Wiew by URL sks3:ffserver 2003:8080) contentdbid={0S54FFOS6-3b. ..
Crawled

ste3:ffserver 2003/ contentdbid={cecdzz229-baab-42. ..
Crawled

http:ffserver2003
Crawled

Rkt server 20035080
Crawled

sps3:/iserver2003: 8080/ site$$$people
Crawled

ska3iffserver2003
Crawled

sks3f{server2003: 5080
Crawled

sps3:[lserver2003: 8080/ site$$$people/bucketid=1
Mok Modified

sps3:ffserver2003: 3080
Crawled

o i server2003 dacs docurnent sftest . p
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Searching PDFs

After you finish indexing PDF files, you can start a search to find text within PDF files. Also,
you can search PDF document properties, such as author, title, etc.

To start a search, please perform the following:

+ Go to the Document Center, and click Search to visit the Search Center > type the
text you want to search > hit Enter.

MOSS TEST
##l search
MOSS TEST | Document Center  News = W Sites

all Sites People

[Mossz007] | 2| advanced search

+ You will see your search results. Click to open one of the PDF files.

MOSS TEST
@4l search
MOSS TEST  Document Center  Mews = W Sites

all Sites People

MOS52007 | 2| advanced Search

Resulk 1-1 af 1, Your search toak 0,19 seconds,

(2
MOSS2007
fittp: /fserver 2003/ Docs/Documents/test Bl - 1KE - Unregistered Retail Cuskomer - 11192007

Page 33



Foxit PDF IFilter Server

i 5 http:/ /server2003, Docs,/Documents; test.pdf - Microsoft Internet Explorer

File GoTo Favorites Help | l":'
: Q@Back -~ &) - [x] [2] . | ) Search ¢ Favorites &) | v m = @
Address I@ http:/{server2003/Docs/Document sitest, pdf j Go |Links =
a-s o0& - NO0e- - -0 |WAH=EE K -
= |l Bookmarks -~
..... D Page 1
i
l4 4 1ot ~ b bl O ©  sa5% - F =g Fie: test[1]pef [7.38 * 9.251n] ,
|2£| Ready ’_l_l_l_’_|o Unknown Zane v
More Help

For more information on how to work with Microsoft Office SharePoint Server (MOSS),
please refer to Microsoft Office SharePoint Server (MOSS) Help included in the product.
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Chapter 4 - Foxit PDF IFilter for
Microsoft SQL Server

Foxit PDF IFilter can help search text in PDF files. After installing Foxit PDF IFilter, it asks
to upload the PDF documents and perform a full population with Microsoft SQL Server
before you start a search.

Note:

Generally, all the instructions in this chapter are for Microsoft SQL Server 2012/2008/2005.
And the screenshots are from Microsoft SQL Server 2012 by default. If there is any
difference between SQL Server 2012 and 2008/2005, we will point it out as well as attach
a screenshot.

Installing Foxit PDF IFilter

Foxit PDF IFilter has two packs respectively for 32-bit Windows and 64-bit Windows. You
can choose one of them to install into your machine according to your system
requirements. Before installing Foxit PDF IFilter, please make sure that Microsoft SQL
Server has been installed successfully.

To install Foxit PDF IFilter on SQL server, please follow the steps as below.
1. Create a new functioning database to store PDF files.

A. Run SQL Server Management Studio.
B. Create a new database.

Right click the Database folder in the Object Explorer and select New Database.
Type your Database name and click OK.

C. Create atable.
Right click the Table folder in the new database and select New Table.

D. Complete the details in the “Column Name” column, the “Data Type” column,
“Length” column, and “Allow Nulls” column.

Foxit PDF IFilter indexes PDF files in SQL Server based on your specified
column names. For example, you may add some fields for PDF files as below:
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E.

QA-5QL2012,pdfindex - dbo.Table_1* X Object Explorer
J Column Name I Data Type | Allow Nulls I
__I PdfText varbinary(MAaX) v
_] Ext nvarchar{50) 2
_}_] oD o ............... l"' ...............
_I ................ [_ ...............

PdfText: stores binary PDF files, whose data type should be
varbinary(MAX).

Ext: stores the file extension of PDF files. It's set as “.pdf’ in this
example. For more information, please refer to
http://technet.microsoft.com/en-us/library/ms142499.aspx

PdfID: designates a unique ID for each PDF file, which will act as the
return value when you're trying to search PDFs.

Note:

The example of the table above is applied for Microsoft SQL Server in this
manual.

Click Save button and enter a name for the table.

Install Foxit PDF IFilter.

A.

Download Foxit PDF IFilter installation pack by the given link in the sales emalil
after purchasing the license. Also, you could get the 30-day trial version of Foxit
PDF IFilter from Foxit Website (http://www.foxitsoftware.com).

Run the Foxit PDF IFilter Setup and follow the steps to complete the installation
on your server.

Notes:

Y VY

Foxit PDF IFilter appears in the program list after installation.

Foxit PDF IFilter has no user interface.

The installer will unzip an add-on called fpdfcjk.bin into the installation folder.
This add-on will help index PDF documents containing the
Chinese/Japanese/Korean characters.

Register Foxit PDF IFilter.

After the installation of Foxit PDF IFilter, it asks to register Foxit PDF IFilter.
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A. Click the “Database Engine Query” button on the toolbar, and execute the
following command to register Foxit PDF IFilter:

Exec sp_fulltext_service 'load_os_resources', 1
Exec sp_fulltext_service 'verify _signature’, 0

Object Explorer SQLQueryl.sql - QA-S..\Administrator (S7))* < [el:Sate]Ruluh bl uta ilyls -5ats ale B F=1a! S0 it

Exec sp_fulltext_service 'load_os_resources’, 1
Go
Exec sp_fulltext_service 'verify_signature', @
Go|
1w0% ~ 4|
3 Messages I
Command(s) completed successfully.

B. The message “Command(s) completed successfully.” means you have
registered Foxit PDF IFilter successfully.

4. Restart the server, or you can stop and start SQL server and the Full-text
Search engine by right-clicking them.

For SQL Server 2012/2008:

A. Click Start > Programs > Microsoft SQL Server 2012/2008 > Configuration
Tools > SQL Server Configuration Manager.

Analysis Services
Configuration Tools
:_: Reporting Services Configuration Manac

= SOQL Server Confiquration Manager

_1 SQL Server Error and Usage Reporting
%3 SQL Server Installation Center (64-bit)
Data Quality Services :_*

B. In the pop-up SQL Server Surface 2012/2008 Area Configuration dialog box,
please select Surface Area Configuration for Services and Connections.

C. Select MSSQLSERVER > Service > click Stop button and then Start button.

D. Select Full-Text Search > Service > click Stop button and then Start button.

For SQL Server 2005:

A. Click Start > Programs > Microsoft SQL Server 2005 > Configuration Tools >
SQL Server Surface Area Configuration.

B. In the pop-up SQL Server Surface 2005 Surface Area Configuration dialog box,
please select Surface Area Configuration for Services and Connections.

C. Select MSSQLSERVER > Service > click Stop button and then Start button.
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D. Select Full-Text Search > Service > click Stop button and then Start button.

5. Confirm the registration.

A. To check if PDF document type has been associated to Foxit PDF IFilter,
execute the following commands.

select document_type, path from sys.fulltext_document_types where
document_type = ".pdf’

B. Check the result under the Results tab. Check the results to confirm success
visually.

Object Explorer SQLQueryl.sql - QA-S.. \Administrator (S3))* > [Kefuiste]beluh belfalailya l=Haets aTul =1l -0 ke
-Iselect document_type, path from sys.fulltext_document_types where
document_type = '.pdf’

wos ~ 4
1 Results I 3 Messagesl

document_type | path l
1 | .pdf C:\Program Files\Foxit Software\Foxit PDF IFilte...

SQLQ'uerylr.sqI”- JiNLﬁC\jinéhi_liu (52))*
Biselecc document type, path from sys.fulltext_ document types where
'—document__type = 1 . pdf’

I

= - e |
[ Results |_‘_3 Messages |

! document_type path
D:\Program Files\Foxit Software\Foxit PDF IFilte...

1

] Results | e Messagesl

document_type I path
1 pdf E:\Program FileshFoxit SoftwarehFoxit POF [Filte...

Note:

To update and uninstall Foxit PDF IFilter, please refer to Updating Foxit PDF IFilter
and Uninstalling Foxit PDF IFilter.

Setting up full-text search

To set up full-text search, you should take the following steps.

1. Confirming the Full-text search service.

Page 38



Foxit

Foxit PDF IFilter Server

A.

Launch Microsoft SQL Server Management Studio and execute the following

command.

print FULLTEXTSERVICEPROPERTY ('IsFullTextInstalled")

Object Explorer SQLQueryl.sql - QA-S.. \Administrator (S3))* X KelEste] b bl ols iyl -9
print FULLTEXTSERVICEPROPERTY('IsFullTextInstalled')

100% - 4|

3 Messages |
1

Check the result by the returned value.

1 = Full-Text installed
0 = Full-Text not installed
Null = invalid input, or error

Installing Full-Text component and service.
Enabling Full-Text indexing

In order to use Full-Text indexing function, you must first check if it has been enabled.

To enable Full-text indexing, please use one of the following two methods.

Launch Microsoft SQL Server Management Studio. Right-click the database you
have created > select Properties > choose Files tab > check “Use full-text

indexing” > OK.
Execute the following command:

exec sp_fulltext_database 'enable’

Object Explorer SQLQueryl.sql - QA-S. \Administrator (S3))* X I

use pdfindex

go
exec sp_fulltext_database 'enable'

100% ~ 4
3 Messages I
Command(s) completed successfully.
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SQLQueryl.sql - JIN...F‘C‘\jin:hi_liu (58))* | JINCHI_LIU-PC.p«
Use pdfindex
go
exec sp fulltext database 'enable'

1 | 1]

_I_"| Messages

Command {(3) completed successfully.

4. Creating a full-text catalog to store full-text indexes.
Please execute the following command.
create fulltext catalog pdfCatalog

5. Creating a unique index.

A. Open the table you have created > right click one of the column names > select
“Set Primary Key”.

QA-5QL2012.pdfindex - dbo.Table_1* > Eela)las s al=1g SQLQ
Colurmn Name I Data Type | Allow Nulls I
| pdfText varbinary(MAX) v

Ext nvarchar{50)

v
@Eﬂo int o
=

€| JINCHI_LIU-PC.pdfindex - dbo.Table 1*| SQLQueryl.sql - JIN..PC\jinchi_liu (52))* |

Column Name Data Type Allow Nulls
PdfText varbinary(MAX) @]
nvarchar(50)
int ]
[

Table - dhu.pdftahle*]f Server2003.ma, . . QLQueryl,sqgl* ]/E

Colurnn Mame I Cata Type I Allcws Mulls I

‘_I PdFText warbinary{fa:)
| ¥3} PafId int

_I Ext nchar{ 10)

_

B. Execute the following command:

A i Y

create unique index ui_pdfindex on dbo.pdftable(Pdfld)
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6.

Create a full-text index
For SQL Server 2012/2008

Right-click the table you have created > choose “Full Text Index” > set for it with all
the default value. Please note the “PdfText” should be checked in Available
Columns and “Ext” should be selected in Type Column.

For SQL Server 2005
Execute the following command:

create fulltext index on dbo. pdftable

(

PdfText — Please assign the column name for full-text index.

)
key index ui_pdfindex on pdfCatalog

with change_tracking auto

Uploading PDFs

1.

To upload PDF files to Microsoft SQL Server, please write a segment of codes.
You could also copy the following example.

For SQL Server 2012/2008
using System;

using System.Collections.Generic;
using System.Web;

using System.Web.Ul;

using System.Web.Ul.WebControls;
using System.Data.SqlClient;

namespace WebApplicationl

{
public partial class _Default : System.Web.Ul.Page
{
protected void Page_Load(object sender, EventArgs e)
{
}

protected void Button1_Click(object sender, EventArgs €)
{

/[Create a byte[] from the input file

int len = FileUploadl.PostedFile.ContentLength;

byte[] PdfText = new byte[len];
FileUploadl.PostedFile.InputStream.Read(PdfText, 0, len);
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/I Insert the image and comment into the database
//SglConnection connection = new
SqlConnection(@"server=QA-SQL2012;database=QA-2012;uid=Administrator;pwd=");
SqglConnection connection = new SglConnection(@"Integrated Security=SSPI;Persist
Security Info=False;Initial Catalog=pdl;Data Source=QA-SQL2012");
try
{
connection.Open();
SglCommand cmd = new SglCommand(“insert into Table_1" + "(PdfText, Pdfld, Ext)
values (@PdfText, @Pdfld, @Ext)", connection);
/I Insert values into the three columns.
cmd.Parameters.Add(new SqlParameter("@PdfText", PdfText));
cmd.Parameters.Add(new SqlParameter("@Pdfld",17));
/I 'You can only upload a pdf file at a time.
cmd.Parameters.Add(new SqlParameter("@Ext", ".pdf"));
cmd.ExecuteNonQuery();

}
finally

{

connection.Close();

}

}
For SQL Server 2005
using System.Web.UI.HtmIControls;

using System.Data.SqlClient;

using System.IO;

public void OnUpload(Object sender, EventArgs e)

{
/I Create a byte[] from the input file
int len = Filel.PostedFile.ContentLength;
byte[] PdfText = new byte[len];
Filel.PostedFile.InputStream.Read(PdfText, O, len);
/I Insert the image and comment into the database
SglConnection connection = new

SqlConnection(@"server=IP_address or server

name;database=pdfindex;uid=username;pwd=password");
try
{

connection.Open();
SglCommand cmd = new SglCommand("“insert into pdftable "

+ "(PdfText, Pdfld, Ext) values (@PdfText, @Pdfld, @Ext)", connection);
/I Insert values into the three columns.
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cmd.Parameters. Add("@PdfText", PdfText);

cmd.Parameters.Add("@Pdfld", 1);// You can only upload a pdf file at a time.
cmd.Parameters. Add("@Ext", ".pdf");

cmd.ExecuteNonQuery();

}
finally
{
connection.Close();
}

}
2. Once if it succeeds, you will be prompted to upload your PDF files as below:

For SQL Server 2012

E‘lhttp:,.f',.f'localhost:1494;'Default.aspu - Windows Internet Explorer

@ http:/flocalhost: 1494 /Default, aspx ,OLI WRl#! X 2 localhost x| |

[ Browse.. || Button |

For SQL Server 2005
HtmlInputFile Example
Select File to Upload: | Erowse... |

Save as file name (no path): |

Upload

Note:

The codes above uses ADO.NET as the data access mechanism, and C# as the
development language.

Starting a full population

After completing the steps above, you should start a full population for the uploaded PDFs.
Actually, there are two ways under SQL Server 2012/2008/2005 to synchronize full-text
indexes with their table data: Full Population and Incremental Population.

1. Full Population

A population when the index entries are built for all the rows in all the full-text
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catalog's tables.
2. Incremental Population

A population only adjusts index entries for rows that have been added, deleted, or
modified after the last population.

You may select to start a full population or an incremental population according to your
needs.

1. To start a full population, right-click the table you created > Full-Text index > Start Full
Population.

2. To start an incremental population, right-click the table you created > Full-Text index >
Start Incremental Population.

Searching PDFs

After you finish indexing PDF files, you can start a search to find text within PDFs. Before
you start a search, you have to verify if the full-text catalog or full-text index has been fully
populated.

To check the population status, please execute the following command:
select fulltextcatalogproperty('PdfText’,'populatestatus’)

You can start a search if the return value is 0.

To start a search, please execute the following command:

USE pdfindex;

GO

SELECT Pdfld

FROM Table_1

WHERE CONTAINS(PdfText, 'Foxit");
GO

Object Explorer SQLQueryl.sql - QA-S.. \Administrator (53))* X

bSE pdfindex;
GO
-]SELECT PdfID

FROM Table 1
WHERE CONTAINS(PdfText, 'Foxit');
GO
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More help

For more information on how to work with Microsoft SQL Server, please refer to Microsoft

SQL Server Help included in the product.
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Chapter 5 - Foxit PDF IFilter for
WSS

Foxit PDF IFilter can help search text in PDF files. After installing Foxit PDF IFilter, you
should upload your PDF documents with Windows SharePoint Services (WSS) before you
start searching.

Installing Foxit PDF IFilter

Foxit PDF IFilter has two versions respectively for 32-bit Windows and x64 Windows. You
can choose one of them to install into your machine according to your system
requirements. Before installing Foxit PDF IFilter, please note that Microsoft SharePoint
Services 3.0 has been installed successfully.

To install Foxit PDF IFilter, please do the following:

« Download Foxit PDF IFilter from Foxit Website (http://www.foxitsoftware.com) onto
the machine where you wish to install it.

« Run the Foxit PDF IFilter Setup program to install the IFilter.

« Add the following registry entry, and then set the registry entry value to pdf:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shared Tools\Web Server
Extensions\12.0\Search\Applications\<GUID>\Gather\Search\Extensions\ExtensionList\38

Please do the following:
e Click Start > Run, type “regedit’, and then click OK.

e In “Registry Editor” dialog box, locate and then click the following registry
subkey:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shared Tools\Web Server
Extensions\12.0\Search\Applications\GUID\Gather\Search\Extensions\ExtensionList

e On the Edit menu, point to New, and then click String Value.
e Type 38, and then press ENTER.
e Right-click the registry entry that you created, and then click Modify.
e Inthe Value data box, type pdf, and then click OK.
« Verify that the following two registry subkeys are present and that they contain the
appropriate values.

Note: These registry subkeys and the values that they contain are created when you installed the
Foxit PDF IFilter on the server.
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e Locate and click the following registry subkey:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shared Tools\Web Server
Extensions\12.0\Search\Setup\ContentindexCommon\Filters\Extension\.pdf

This registry subkey must contain the following registry entry:

Name: Default
Type: REG_SZ
Data: {987f8d1a-26e6-4554-b007-6b20e2680632}

# Registry Editor

;I MName Type | Data

S
Edit String

WYalue name:
| IDiefat]

WYalue data:

(9871

320
Cacat_|

e Locate and click the following registry subkey:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shared Tools\Web Server
Extensions\12.0\Search\Setup\Filters\.pdf

This registry subkey must contain the following registry entries:

1) Name: Default
Type: REG_SZ
Data: (value not set)
2) Name: Extension
Type: REG_SZ
Data: pdf
3) Name: FileTypeBucket
Type: REG_DWORD
Data: 0x00000001 (1)
4) Name: MimeTypes
Type: REG_SZ
Data: application/pdf

Mame | Twpe | Data
I{DeFauIt]l REG_57 (value naok sek)
(ab]Extension REG_SZ pdf
BH)FileTypeBucket REG_DWORD 000000001 {1}
MimeTypes REG_SZ applicationfpdf

« Download PDF icon from http://www.foxitsoftware.com/images/icons/pdficon.gif .

+ Copy the downloaded .GIF file to "Drive:\Program Files\Common Files\Microsoft
Shared\Web Server Extensions\12\Template\Images".
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Edit the file “Drive:\Program Files\Common Files\Microsoft Shared\Web server
extensions\12\Template\XmN\DOCICON.XML":

e Right-click DOCICON

XML file > click Open With > select Notepad.

e Add an entry for the .pdf extension. For example, where ICPDF is the name of

the .gif file:

<Mapping Key="pdf" Value="pdficon.gif"/>

Il poacoN.XML - Notepad §

File Edit Format View Help

<DocIcons>

<ByProgID>
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=

</ByProgID>

<ByEXxtension>

<?xml version="1.0" encoding="utf-8"7>

"Excel.Sheet" value="ichtmxls.gif" EditText="Microsoft Excel" Openc
"FrontPage.Editor.Document” Vvalue="ichtmfp.gif" EditText="Microsoft
"Inforpath. Document” value="icxddoc.gif" EditText="Microsoft InfoPat
"InforPath. Document.2" value="icxddoc.gif" EditText="Microsoft Infopr
"InfopPath. Document. 3" value="icxddoc.gif" EditText="Microsoft InfopP
"InfoPath. Document.4" value="icxddoc.qgif" EditText="Microsoft InfoP

"0oDC.Cube" value="icodcc.gif" EditText="Microsoft Excel" OpencContro—

"ODC.Database" value="icodcd.qgif" EditText="Microsoft Excel" Openco
"obc.Table” value="icodct.gif" EditText="Microsoft Excel" OpencContr
"Onenote.Notebook" value="icnotebk.png" EditText="Microsoft OneNote
"PowerPoint.S1lide" value="ichtmppt.gif" EditText="Microsoft PowerPo
"Publisher.Document” va1ue="ichtmpug.gif" EditText="Microsoft Publi
"sharepoint.Documentset” value="icdocset.gif"/>
"SharePoint.webPartPa?e.Document" value="icsmrtpg.gif" EditText="Mmi
"Visio.webDrawing" value="icvdw.gif" EditText="Microsoft Vvisio" Ope
"word. Document” Value="ichtmdoc.gif" EditText="Microsoft word" Open
"XDocs.Document” value="icxddoc.gif" EditText="Microsoft InfoPath"
"Sharepoint.Link" value="DOCLINK.GIF"/>

"SharePoint. SearchadminrReport” value="icsadrep.gif" EditText="Micro

(?Mapping Key=

"pdf" value="pdficon.gif"/> ]

<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=
<Mapping Key=

"accdb" value="1icaccdb.gif" EditText="Microsoft Access" OpencContro
"accdt" value="1icaccdb.gif"/>

"accdc" value="1icaccdb.gif"/>

"accde" value="icaccde.gif" EditText="Microsoft Access" OpenContro
"accdr" va1ue="icaccde.gif" EditText="Microsoft Access" OpenContro
"asax" value="icasax.gif" opencontrol=""/>

"ascx" value="jcascx.gif" EditText="Microsoft SharePoint Designer"
"asmx" va1ue="1casmx.gif" opencontrol=""/>

"asp" value="ichtm.gif" openControl=""/>

"aspx” value="1ichtm.gif" EditText="Microsoft sharepoint Designer” O
"bmp" value="icbmp.gif"/>

=10l

<Mapping Key="cat" value="iccat.gif" opencontrol=""/>

| |

e Onthe File menu, click Save, and then quit Notepad.

Note: This directly changes the icons shown on the search result. Make sure this change takes effect in

the appropriate server where search results are displayed i.e. any web front end (WFE) that supports

user interfacing.

Perform an iisreset:

e Click Start > Run > type “cmd” in the Open line> click OK > type “iisreset” at the
command prompt > hit Enter.
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W WINDOWS system32', crnd.exe

Microsoft Windows [Uersion 5.2_.37981
(G} Copyright 1985-2003 Microsoft Corp.

F:“Documents and Settings“fAdmin istrat

Attempting stop...

Internet services successfully stopped
Attempting start.__.

Internet services successfully restarted

F:~Documents and Settings“Administrator>_

e Close the window.

Note: In WSS2.0, Foxit PDF IFilter is installed on the computer which has SQL2005
server. In WSS3.0, Foxit PDF IFilter is installed on the computer which has WSS3.0.

Click to check the parts of Updating Foxit PDF IFilter and Uninstalling Foxit PDF IFilter

Uploading PDFs

To upload PDF files to Windows SharePoint Services 3.0, please do the following:
1. Open your Windows SharePoint Services site and click Shared Documents.
2. On the Upload menu, please click Upload Document.

3. Click the Browse button to upload a PDF document and click OK. When it has been
uploaded, you will be returned to the Documents page where you will see that your PDF
file has been uploaded.

Team Site
g Si
E@ Team Site

Home

=] Team Site > Shared Documents
| = Shared Documents
Wiew All Site Cantent Share a document with the team by adding it to this document library.
Documents Mew ~  Upload - Actions = Settings ~
= Shared Documents
® IFiterTest 2 testl Dhew 1/5/2008 4:49 PM TESTPC2-W3k-64|admiristrator

Lists
= Calendar
= Tasks

4. Stop and then start the Windows SharePoint Services Search service. Please do the
following:

e Click Start > Run, type “cmd”, and then click OK.
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e Stop the Windows SharePoint Services Search service. To do this, please type "net
stop spsearch" at the command prompt, and then press ENTER.

e Start the Windows SharePoint Services Search service. To do this, please type "net
start spsearch" at the command prompt, and then press ENTER.

e Exit the command prompt.

JFAWINDOWS system 32 cmd.exe

Microsoft Windows [Uersion 5.2.37981
(C>» Copyright 1985-2883 Microsoft Corp.

F:“Documents and Settings\ﬂdministrat
The Windows SharePoint Services Search serv —rtopping .

The Windows SharePoint Services Search service was stopped successfully.

F:“Documents and Settings\ﬂdministrat
The Windows SharePoint Services Search servitcE fo-orabting.

The Windows SharePoint Services Search service was started successfully.

F:“Documents and Settings“Administrator>

Searching PDFs

After you finish uploading PDF files, you can start a search to find text within PDF files.
Also, you can search PDF document properties, such as author, title, etc.

To start a search, please perform the following:

« Go to the Shared Documents, please type the text you want to search in the search

box > and then click the Search button

Team Site

Welcome TESTnGR At adinisator ~ | (@)
§# Team Site This List =] [wss p
Home | i Actions - |

o | Team Site > Shared Documents
| =N Shared Documents

View All Site Content share a document with the team by adding it to this documert library.

Documents o 1 e et e view: | All Documents
= shared Documents

= [FilterTest

test1 T rew 1{8{2008 4:43 PM TESTPCZ-W/3K-84\administrator

« You will see your search results. Click to open one of the PDF files.
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Team Site

@l Team Site
Home

——

Search for items containing:

| This List | |wss F'|

Result 1-1 aof 1, Your search took 0,06 seconds,
Results by Relevance | View by Modified Date

(4 testl.pdf

WsE

htkp: fteskpoZ-w3k-645hared Documentstest 1, pdf - 1KE - Unregistered Retail Cuskomer - 1082008

| test1[1].pdF - Foxit Reader 2.2 - [test1[1].pdf]

'@Eile Edit Wiew Language Document Tools Advanced Window Help ' Foxit Reader Pro,work like a pro! J _|ﬁ||5|
e el 4 » vo oI [N DO0e - -
IO eaEaiBEr-n )0 | ] =
|
Ready |4 4 111 b Pkl | o © |B?.15% - LH B O File: besti[1].pdf [7.38 * 9,250

Note: If the Windows SharePoint Services 3.0 Web site already had PDF documents
before you installed the Foxit PDF IFilter on the server, you may have to perform an
additional step. After you install and configure the Foxit PDF IFilter on the server, modify a
property of the existing PDF documents on the server. For example, modify a metadata
property such as the title, or upload the PDF documents to the Windows SharePoint
Services Web site again. When you do this, the Windows SharePoint Services Search
service crawls the existing PDF documents again.
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More Help

For more information on how to work with Windows SharePoint Services (WSS), please
refer to Windows SharePoint Services (WSS) Help included in the product.
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Chapter 6 - Foxit PDF IFilter for
Microsoft Exchange Server

Working in Exchange 2010

Modifying registry information

1. Install Foxit PDF IFilter on the platform where Exchange 2010 was installed.
2. Modify the registry information

1) Click start > run > type regedit to open the Registry Editor (regedit)

2) Locate the registry subkey through the following path:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ExchangeServer\v14\MSSearch\CLSI
D\{987f8d1a-26e6-4554-b007-6b20e2680632}

Add the following string value to the subkey by double-clicking 2% {Pefault) -

Subkey Value

{987f8d1a-26e6-4554-b007-6b20e2680632} Drive:\Program Files\Foxit Software\Foxit
PDF IFilter\pdffilt.dll

3) Create the following string value in the subkey you modified in Step 2):

Value Name Type Value Data
ThreadingModel String (REG_SZ) Both
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&' Registry Editor
File Edit View Favorites Help

=1olx|

= | CLSID ;I MName | Type | Data
-~ | {10A2BDBC-7130-420C-9320-A92CC 1919206}

- |, {12CE94A0-DEFB-11D2-831D-00600833A857} REG_S7 Both

REG_SZ C:\Program Files\Foxit Software\Foxit PDF IF\Iher\pdfﬁ\t.dII]

- |1 {1D45F 57D-47D2-4AEE-AG9B-593EC558773F )
-« | {20EB23C2-62F 3-4638-96BD-90F 476 TR4EBC}
- | {2CSF6BEB-C5B0-4286-A5EE-84C24DCODEEF}
- | {2C586 186-5 164-9E 14-A 1A7-D3FB30C 3F5CF}
| {312AB530-ECCS-496E-AEDE-CIEEC 5392499}
| {31b7c920-2880-11d0-8d51-00a0c908dbf 1}
| {37cB4fa0-d3db-11d0-8d51-00a0c908dbf 1}
| {3D50F 14F-649F ~4CBC-8530-F 18FEDESCF 50}
| {41B9BE0S-B3AF-460C-BFOB-2C0D44A0938 1}
- | {45EACA36-DEES-de4a-A26D-5C201902346D}
- |, {52BE2FB7-1638-408A-9A98-742398087DB 5}
- |1 {52F IDEDC-C51B-11D2-9A7C-00004F5E88ED}
|, {5A986233-3C59-4B31-944C-UESE0DESEECS}
- || {61A48126-EF74-4D4A-9DDA-43FD542CAD 15}
- |, {61DBDB6A-8D1A-4EB0-307C-E4C 1BBCEFO9A}
| {65170AE4-0AD 2-4fa5-B3BA-FCDTIEIDAB2S}
| {68CE024E-T7ED-11D5-8528-00C04F68155C)
| {6BDCTIDC-2327-4040-8F03-5006A9805049}
| {78fe6s5a-186e-4108-96e3-77b586c 1332}
| {FE352021-6906-4553-86AC-4308008FF9 13}
- |, {87824713-C8B0-4379-8556-1689764E4237}
| {92F2118AE813-4A4D-9DE2-FI6AIDCO2CS3}
- || {954F1760-C 1BC-1100-9692-00A0CI0B 146E}
(| {98718d1a-26e6-4554-b007-6b20e 2680632 ) _

S i =

<]

<]

I

|ComputEr‘.HKEY_LOCAL_M#CHINEEOFFWAREWiUoso&\ExmangESErVEr‘w 149\MSSearch\CLSID\{987f8d 1a-26e6-4554-b007-6b 20e 2680632}

4) Locate the registry subkey through the following path:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ExchangeServer\vl4\MSSearch\Filters
Add the following string value to the subkey by double-clicking 2%/ (Default)

Subkey value

.pdf {987f8d1a-26e6-4554-b007-6b20e2680632}

Please refer to the following picture:

&' Registry Editor I ]

File Edit View Favorites Help

----- , html ;I Mame Type |D313

----- J htw b (Default) REG_SZ { {387f3d 1a-26e6-4554-b007-6b 2022680632} )
----- ) hix
..... | e
----- , .ibg
..... L adl
----- J Jnc
..... | inf

..... | .ppt
..... | .pptx
..... =

..... | .reg
..... Crtf

..... . .stm
..... [ bt

B — — |

[computef{HKEY_LOCAL_MACHINE\SOFTWARE WMicrosoft\ExchangeServer v 14\MSSearch Filters\.pdf )

a L=
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3. Please restart the Exchange Search service with following the step shown below:
1) Click Start > Run > type “cmd” > click OK > type “iisreset” in the command prompt

window > press Enter.

¢ Command Prompt

C:“Documents and Settings“AdministratorPiisreset

Attempting stop...

Internet services successfully stopped
Attempting start._._.

Internet services successfully restarted

C:~Documents and SettingssAdministratori_

2 ) Restart the Microsoft Search (Exchange) Service through the services console or type

the following commands in the Exchange Management Shell.

Stop-Service msftesql-Exchange —Force
Start-Service MSExchangeSearch

Indexing PDF attachments

1. Start ‘services.msc’.

2. Restart MSExchange Information Store service.

3. Create an index by executing the following command in the Exchange Management
shell.

ResetSearchindex.psl -force —all

After the system completes the indexing, the result will be saved in the same location with
Mailbox database.
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-0l

Show full output for a cmd: <cnd> | format—list
Tip of the day #7:

ICTRL+C is the equivalent of the hard-break command in the Exchange Management S£hell. If a command is taking too long to
run or you want to cancel an operation guickly, press CTRL+C to stop execution.

WERBOSE: Connecting to EXB1.cpandl.com
WERBOSE: Connected to EXB1.cpandl.com.
[P§] C:sMWindows\system32> (cd $env:exchangeInstallpaths\Scripts
[P5]1 C: \Plnglam Flleﬂ\chlu“nft\Exchange ServersUld\Scripts> ~resetSearchlndex.psi —fnlce = 11
‘Microsoft Exchange Search Indexer (MSExchangeSearch)”
‘Microsoft Exchange Search Indexer (MSExchangeSearch)’
chlnﬂoft Exchange Search Indexer (MSExchangeSearch?>’ to finish gtnpplng
MSExchangeSearch service stop
Deleting catalog for Mailbox Datahaﬂe A28A748605

removing: C:sProgram Files\Microsoft:\Exchange ServersUl4:\Mailhox“Mailbox Database B28@87486@5%\CatalogData-ceh?42d4-adda-
4848-h298-50182eab2f1f -h543ebc3-ab?7-4%a2-9988-3a6d64542c64

MSExchangeSearch service Started
[P8]1 C:“\Program Files\Microsoft:\Exchange Server\Uld\Scripts>

Alternatively, you can use the resetSearchindex.psl script. This PowerShell script
accepts the name of the database you want to work with as an input parameter. As shown
above, to get started, enter cd $env.exchangelnstallpath\Scripts, then run the script by
entering .\resetSearchindex.ps1l which is followed by the name of the database, i.e.
\resetSearchindex.psl EngineeringMailboxDb.

Searching PDFs

After finishing indexing PDF files, you can find the target PDF file with Foxit PDF IFilter by
searching the text within PDF files or its properties, such as author, title, etc.
To search a PDF file, please perform the followings:

1. Visit the website https://exchangesever/owa to open OWA (Outlook Web App).
(i.e. https://ex01.cpandl.com/owa)
2. Login the mailbox in which you want to search PDFs.

........

Y -
"% Options -

0| Qutlook Web App - El - (=] M= v~ Page~w 3Safety~ Tools~ gv >

Microsoft*

Outlook'Web App

Security
(=} This is @ public or shared computer

This is a private computer

m

Use the light version of Outlook Web App

Domain‘user name: |lintestlf@cpandl.com

Password:

Cnnnected to I'llcl osoft Exchange

Done 4" Trusted sites | Protected Mode: Off fa ~ H100% ~

3. Please type the words you want to search in the search box, and then click the Search
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button @

The PDFs that contain the search terms will be showed under the Search box.

i | B options | lintest1 .| Log Off

Mail <& || Inbox {3 results in Inbox) @ Help
= 59 linkest1 all Slnew - BH- B X B-H Sk Reply | E@Replytoal (3 Forward
ﬁ Calendar
%= Contacts resulks X - ¥ Undeliverable: 229
o Deleted Ttems
@ Drafts Arrange by Date - MNewestontop Microsoft Exchange
r_7| Inbox (5) Yesterday * gent: Thursday, July 07, 2011 11:28
@ s E_r:’l.?il.... 7 [@& Microsoft Exchange Thu11:28 To: lintest!
H Mail Undeliverable: 229 ) ) o [«]
@ Micrsoft Exchange Thullizg @ Delivery has failed to these recipients or J
5 calendar Undeliverable: distribution lists:
83 Contact Last Week
—J tontacts ) lntestl Thuefao lintestl@chenlin. foxitsoftware.com
;’j Tasks o Microsoft Exchange has been frying to deliver this message
; without success and has stopped tying, Plesse fry sending this
=, rmessage again, or provide the following disgnostic text to vour
D t:
rFé oeuments ~  systern administrator, =]
@ Public Folders Ttems 1 to 3 of 3 < | [
@ é O Internet
4. Double-click to open the target PDF.

7] FoxitPDFIFitter20_Manual.pdf - Foxit Reader - [FoxitPDFIFiter20_Manual.pdf] ol olelx

I WERET T YAl (= =1 T

. File Edit View Tools Comments Forms Help

R aga Qe 0/RH

| FoxiPDFFFiter20_Menua.. ) Protect PDFs with AD RMS
@tz.o -- a professional tool that helps you to index PDF files. i
B

tion that extracts the contents, properties, bookmarks from
and return the indexed@to the search engine so that
2nts with keywords.

OF 1.7 specification and can be used in many Microsoft

4

o

»

| | :
& ©[606/53) 0 6 &= | GEHE ww O—0—@

I

Work in Exchange 2007

Modifying the registry information of Foxit PDF IFilter

a) Install Foxit PDF IFilter on the platform where Exchange 2010 was installed.
b) Modify the registry information.

1) Click start > run...> type regedit to open the Registry Editor (regedit)

2) Locate the registry subkey through the following path:
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HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Exchange\MSSearch\CLSID\
Add the following string value to the subkey by double-clicking 2! (Default) -

Subkey

Value

{987f8d1a-26e6-4554-b007-6b20e2680632} | C:\Program Files\Foxit Software\Foxit PDF
IFilter\pdffilt.dll
3) Create the following string value in the subkey you modified in Step 2):
Value Name Type Value Data
ThreadingModel REG_SzZ Both
Flags REG_DWORD 1
£ Registry Editor =10 x|
Eile Edit View Favorites Help
{1 {66B37110-86F2-11CE-BESA-00AA00S1FEZD, 4| [ Name [ Type [ Data
{11 {68CAD24E-77E0-11D5-8525-00C04FE8155C)H t) REG_SZ C:\Program Files\Faxit Software}Foxit PDF m\m\@
{1 {ED3RCE10-7F1C-11CE-BEST-O0AANOS1FEZ0) [ REG_DWORD 0x00000001 (1)
~{_]] {6DE70SAS-6467-43DC-9CE3-CCFEDBEIRE4S) @b ThreadingModsl  REG_SZ Both

{1 {737FCIB5-BCEE-4953-B7DE-B7IAT2ZASI2ASE
D 473D009FE-7D05-454C-94C2-EDD102994204)

~+{Z]] {BE0D2800-86F4-11CE-BESS-00AA005LFE20}

{1 {9473F640-7F1C-1 1 CE-BES7-00AADDS1FEZ0}
D {95679344-4566-42CD-9B79-2F5784D7 0255}

{1 {97EBEFCS-420A-43E0-9CEC-B4FDEIG20F 1AL J

(] {9EABDET6-ADSE-43ED-B00E-730587 7 ID3F6T
+{Z]] {A9FFRE0Z-DE34-47B3-8434-0075DC0G04B0}
{1 {BOS16FFO-7F1C-11CE-BES7-00AADDSIFEZ0}

D 4C731071F-ACED-11D1-8DF3-00CO4FEEEFSF}
~+{{] {C7310720-4CE0-1101-60F3-00CO4FBEEF4F}
{1 {CCA22CF4-59FE-11D1-EBFF-00CO4FBI7FDA}

D {CEDCO1CT-59FE-11D1-BEFF-00CO4FEI7FDA)
-+{Z1 {D99F7E70-7F14-11CE-BES7-00AA00SLFER0}
{1 {E0CAS340-4534-11CF-B952-00AA005 LFE20}

D {EEED4CZ20-7F 1B-11CE-BES7-00AA005 LFEZ0}
-{{]] {FD86BSD0-12CE-11CE-B031-00AM04BEBLF,

=+ Fiters
-] .ascx
-1 \asm
0 asp
23 .aspx
1 pat = [ i
|My ComputeriHKEY _LOCAL_MACHIME\SOFTWARE Microsoft\Exchange\MSSearchCLSIDY {987F8d 1 a-26e6-4554-b007-6b20e2680632) ~

4) Locate the registry subkey through the following path:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Exchange\MSSearch\Filters.
Add the following string value to the subkey by double-clicking **}{Default)

Subkey

value

.pdf

{987f8d1a-26e6-4554-b007-6b20e2680632}

Please refer to the following picture:
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& Registry Editor =131x

Fille Edit ‘iew Favorites Help

- hkx ﬂ Mame Type | Data

- b [ab]pefait) REG_SZ @Fad1a-2555-4554-bnn?-6b20e2680@
D ibg
-0l
- ine
-2 inf
-2 ini
{:l Jdn
Q5
-7 log
D M
D it
{27 ode
T4
-2 ot
20 ppt
=i
3 reg
D f
D sk
D bt
D ul
D whs
D by
{:l e
{20 s
0
@] CLaID
[ GlobaladminBlob
-1 Language
E--[“_‘l Plugins =[xl | D

‘My CompukeriHKEY _LOCAL_MACHINEISOFTWAREIMicrosoftiExchangeiM3searchiFiltersy. pdf

B

3. Please restart the Exchange Search Service with following the step shown below:
1) Click Start > Run > type “cmd” > click OK > type “iisreset” in the command prompt

window > press Enter.

ommand Prompt

C:~Documents and SettingssAdministratorlFiisreset

Attempting stop...

Internet services successfully stopped
Attempting start...

Internet services zuccessfully restarted

C:~Documents and SettingssAdministrator’_

2 ) Restart the Microsoft Search (Exchange) service through typing the following

commands in the command prompt window.
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net stop msftesql-exchange
net start msexchangesearch

Command Prompt

Microzoft Windows [Uersion 5.2_.37901
CC> Copyright 1985-20003 Microsoft Corp.

C:~Documents and Settings“~Administrator> net stop mzftesgl-exchange
The following services are dependent on the Hicrosoft Search <(Exchange) service

étupping the Microsoft Search <(Exchange? service will also stop these services.

Microsoft Exchange Search Indexer

Do you want to continue this operation? <Y¥Y-N> [N1:- |y
The Microszoft Exchange Search Indexer service iz stopping...
The Microsoft Exchange Search Indexer service was stopped successfully.

The Microsoft Search (Exchange) service is stopping.
The Microsoft Search (Exchange? service was stopped successfully.

C:~Documents and Settings“Administratorlfnet start msexchangesearch
The Microsoft Exchange Search Indexer service is starting.
The Microsoft Exchange Search Indexer service was started successfully.

C:“\Documents and Settings“Administrator>

Indexing PDF attachments

1. Start ‘services.msc’

2. Restart Microsoft Exchange Information Store service.

3. Create an index by executing the following command in the Exchange Management
Shell.

ResetSearchindex.ps1 -force

After the system completed the indexing, the result will be saved in the same location
with Mailbox database.

achine: admin-b102bad61 | Scope: chenlin.foxit.com

Get general help: help

Get help for a cndlet: help <cmdlet—-name> or <cmdlet—-name> -7
Show guick reference guide: guickref

Exchange team blog: gqet—exblog

Show Ffull output for a cmd: <cmd> | format—list

Tip of the day #18:
CTRL+C is the equivalent of the hard-hbreak command in the Exchange Management Sh

ell. If a command is taking too long to »un or you want to cancel an operation g
nwickly,. press CTRL+C to stop execution.

[F5]1 C:vDocumentz and Settings“Administrator’ResetSearchlndex.psl —force
WARMING: Waiting for service 'Microsoft Exchange Search Indexer
({MSExchangeSearch)’ to finish stopping...

MSExchangeSearch service stopped

MSExchangeSearch service Started

[P5]1 C:~Documents and Settings™Administrator>
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Searching PDFs

After finishing indexing PDF files, you can find the target PDF file with Foxit PDF IFilter by
searching the text within PDF files or its properties, such as author, title, etc.

To search a PDF file, please perform the followings:

1. Visit the website https://IP/owa/ (i.e. https:// 192.168.0.128/owa)

2. Click to open a category that contains the target PDF file.

3. Please type the words you want to search in the search box, and then click the

Search button @

The PDFs that contain the search terms will be showed under the Search box.

ti Office Outlook Web Access ", | B options | intestt ~ | Log off

Connected to Microsoft Exchange

Mail <& || Inbox {3 results in Inbox) @ Help
= 59 linkest1 all Slnew - BH- B X B-H Sk Reply | E@Replytoal (3 Forward
ﬁ Calendar
% Contacts results X - ¥  Undeliverable: 229
o Deleted Ttems
[ Drafts Arrange by: Date - MNewestontop  + Microsoft Exchange
r_7| Inbox (5) Yesterday * gent: Thursday, July 07, 2011 11:28
r-a s E_r:’l.?il.... 7 [@& Microsoft Exchange Thu11:28 To: lintest!
H Mail Undeliverable: 229 ) ) o [«]
@ Micrsoft Exchange Thullizg @ Delivery has failed to these recipients or J
5 calendar Undeliverable: distribution lists:
85| contacts Last Week
) lntestl Thuefao Im_testl@chenlln.fclmtsuﬁware.cum
;’j Tasks o Microsoft Exchange has been frying to deliver this message
. without success and has stopped tying, Plesse fry sending this
=, rmessage again, or provide the following disgnostic text to vour
D t:
rFé oeuments ~  systern administrator, =]
@ Public Folders Ttems 1 to 3 of 3 < | [
@ é O Internet

4. Double-click to open the target PDF.

11| FoxitPDFIFilter20_Manual.pdF - Foxit Reader - [FoxtPDFIFIter20_Manual.pdf] ol - = x

FE R ERED 1534 =TS E S

. File Edit View Tools Comments Forms Help

D AKABHED © 0B

FoxtPDFIFiter20_Manua... (¢

B{2.0 -- a professional tool that helps you to index PDF files. -
0

tion that extracts the contents, properties, bookmarks from
and return the indexed@to the search engine so that
2nts with keywords.

JOF 1.7 specification and can be used in many Microsoft

<

[ b

| |
& 0 6(6/53) Joee=|0EmY 2wk -O—F—@ |
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Chapter 7 - Additional Information

Microsoft Developer Support

Foxit PDF IFilter is a Dynamic Link Library (DLL) file that provides a bridge between a
Microsoft indexing client and a library of PDF files. It consists of code that understands the
PDF Format as well as code that can interface with the indexing client. When an indexing
client needs to index content from PDF files, it will look in its registry for an appropriate
DLL and will find the Foxit PDF IFilter. Foxit PDF IFilter will return text to the indexing
client. The indexing client will then index the results and return the appropriate results to
the user.

Language Support

This section lists languages supported by Foxit PDF IFilter.

¢ German

e« French

« ltalian

« English

« Spanish

e« Portuguese
e Russian

« Chinese (traditional and simplified)
« Korean

e« Japanese

« Arabic

« Hebrew
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Contact Us

Feel free to contact us should you need any information or have any problems with our
products. We are always here, ready to serve you better.

o Office Address:
Foxit Corporation
42480 Christy Street. Suite 201
Fremont CA 94538
USA

e Sales:
1-866-680-3668 (24/7)

e Support:
1-866-MYFOXIT or 1-866-693-6948 (24/7)

e Fax:
510-405-9288

o Website:
www.foxitsoftware.com

e E-mail:

Sales and Information - sales@foxitsoftware.com

Technical Support - support@foxitsoftware.com

Marketing Service - marketing@foxitsoftware.com
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